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Introduction

This manual contains installation and operation information for the Zebra P100i Card Printer
manufactured by Zebra Technologies Corporation.

Description

The P100i provides full color dye sublimation or monochrome thermal transfer single side
printing on standard 2.125 inch by 3.375 inch (54 mm by 86 mm), PV C or PV C Composite
plastic cards. Its single card feed isideal for low volume applications and applications that use
avariety of plastic cards (for example, cards pre-printed with certain information). It utilizesa
Load-N-Go™ ribbon cartridge with integrated card cleaning roller for easy ribbon changing or
replacement.

A variety of options (some of which can be factory-installed or field-installed as upgrades) are
available, making the P100i configurable for varied application environments:

» Magnetic stripe encoder option
» Contact encoder and/or contactless smart card options
» USB or USB and Ethernet interface option

Its auto-switching 100 ~ 240 Volts AC, 50 ~ 60 Hz external power supply uses interchangeable
power cords for maximum flexibility.
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Introduction
P100i Part Numbers

P100i Part Numbers

The Part Number of a particular P100i Printer is shown on alabel affixed to the bottom of the
printer; that Part Number identifies the specific configuration for that printer. This chart shows
the configurations that are available.

PART NUMBER

DESCRIPTION

P100i -

Base Printer
P100i Single Card Feed, Single-Sided Color Card Printer

Smart Card Options
None
Contact Encoder
Contact Encoder & MIFARE contactless
MIFARE contactless

Magnetic Encoder
None
Yes (select defaults below)

Magnetic Encoder Defaults
None
Stripe Down, HiCo/LoCo

Miscellaneous
Magnetic Encoder only upgradeable board
Upgradeable board for Smart Card Options, Magnetic
Encoder, and Ethernet

Interface
USB Only
USB and Ethernet

Power Cords
U. S. and Europe
U. K. and Australia

Windows Drivers and User Documentation included on one CD
(Software & Documentation Package) which contains Multi-
language documentation - English, Spanish, French, German,
Chinese, Italian, and Portuguese

Starter Kit
No Starter Kit
Starter Kit (including 100 - 30 mil PV C cards and one Black
ribbon, part number 800015-901)
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Introduction
Features, Controls, and Indicators

EXAMPLE

P100i Printer, No Smart Card Optionsinstalled, Magnetic
P100i - OM1UC - | DO | Encoder (Stripe Down, HiCo/LoCo), Board upgradeable for
Smart Card Options, USB and Ethernet interfaces, U.S. and
European Power Cords, Windows Driver and User
Documentation CD, No Starter Kit

ACCESSORIES

105912-9xx | P100i Cleaning Kit, includes 4 sets of print engine cleaning cards

Features, Controls, and Indicators

The picture below points out some of the printer’s external features. (See Chapter 3 for an

interior view.
Covered Card and Lid
Cleaning Roller Release
Storage Area \ Button
LCD

Display
Panel

Multi-
Function
Control
Button

Card Entry / Exit Slot

Covered Card and Cleaning Roller Storage Area

Opening the translucent cover gives access to a storage area where you can keep cards and
spare Cleaning Rollers. This can be useful for applications that require use of various cards.

Lid Release Button

Pressing the Lid Release Button allows the printer’s lid to swing open. This givesinternal
access for changing the Ribbon Cartridge, changing Cleaning Rollers, and cleaning the printer.

980590-001 Rev. A P100i User’s Manual 3
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Features, Controls, and Indicators

LCD Display Panel

The LCD Display Panel displays printer status information. Messages also aert the user of the
need for action, and indicate certain fault conditions.

Multi-Function Control Button

The Multi-Function Control Button initiates severa functions; these are described in the
appropriate sections of this document.

Card Entry / Exit Slot
A card isinserted part-way into the Card Entry / Exit Slot. The card will be drawn into the

printer, printed, encoded, or decoded as specified by the application program, and then be
gjected out through the Card Entry / Exit Slot.

Rear Panel Connectors, Controls, and Indicators

The figure below shows the rear of the P100i Printer with the standard USB interface.

Power

j jt Socket

USB o Power
Port ﬁ Switch
I E— | N E—
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Features, Controls, and Indicators

If your P100i Printer includes the Ethernet option, the rear of the printer will look like the

figure below.
Power
j!: jt Socket
uSB Power
Port oolg Switch
| N E—
Network Ethernet Ethernet Ethernet
Status / Adapter Reset Connector
Activity Status Button

Indicator Indicator

For Ethernet connection, refer to Appendix C, Connecting to a Network.

Ethernet Adapter Status Indicator

1. During normal operation, the LED is solid for more than 30 seconds. This
indicates all the hardware is functioning properly, and the Ethernet Adapter has detected
the presence of the network. It does not mean the Ethernet Adapter has an IP address or is
attached to a printer queue.

2. If the LED isslowly flashing (1 time/sec), the Ethernet Adapter istrying to print.

Network Status/Activity Indicator

1. If the LED issolid , a100Base link is established.
2. If the LED isflashing , a100Base link is established, and network activity has
been detected.

3. If the LED issolid ORANGE, a10Base link is established.

4. If the LED isflashing ORANGE, a10Base link was established, and network activity has
been detected.

980590-001 Rev. A P100i User’s Manual 5
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Features, Controls, and Indicators

LCD Panel Messages

LCD Panel messagesfall into three categories:

Operationa

Warnings

Errors

Operational Messages are displayed during the Printer’s normal

operation.

Warnings alert the operator to action that should be taken; the printer will

generally continue operation.

Errors are displayed when a situation causes the printer to stop operating.
Depending on the cause of the error message, restarting the printer or
curing the displayed Error may return the printer to operational status, or

the printer may require troubleshooting and repair.

MESSAGES

Operational

INITIALIZING

READY

DOWNLOADING DATA

MAG ENCODING

PRINTING CYAN

PRINTING YELLOW

PRINTING MAGENTA

PRINTING BLACK

PRINTING OVERLAY

DOWNLOADING FIRMWARE

CONTACT ENCODING

CONTACTLESS ENCODING

REMOVE CARD AT EXIT

CLEANING

REMOVE RIBBON THEN CLOSE LID

FEED LONG CLEANING CARD IN EXIT

REMOVE LONG CLEANING CARD

SINGLE CARD READY-PRINT OR EJECT

INSERT CARD

REMOVE CARD

P100i User’s Manual
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Features, Controls, and Indicators

MESSAGES

Warnings (Printer will still operate)

CLEAN PRINTER

CHECKING RIBBON

CLEANING CYCLE

CLEANING HEAD

CLEANING ROLLERS

ENCODING ERROR

CLEAN MAG HEAD

INVALID MAGNETIC DATA

REMOVE RIBBON

Errors (Printer will not operate)

CHECK RIBBON

OUT OF RIBBON

MECHANICAL ERROR

COVER OPEN

PARAMETER ERROR

COMMAND ERROR

CONTACT ERROR

CONTACTLESS ERROR

INVALID CONTACT DATA

INVALID CONTACTLESS DATA

Refer to Chapter 6 for Troubleshooting Procedures.
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Introduction
Icons

Ilcons

Throughout this manual, different icons highlight important information, as follows:

Note « Indicates information that emphasizes or supplements important points of the main
text.

Advisesyou of information that is essential to complete atask, or points out the importance of
specific information in the text.

/4\ Electric Shock Caution « Warns you of a potential electric shock situation.

Electrostatic Discharge Caution « Warns you of a situation where electrostatic
discharge could cause damage to electronic components.

Caution « Advises you that failure to take or avoid a specific action could result in
physical harm to you, or could result in physical damage to the hardware.

8 P100i User’s Manual 980590-001 Rev. A
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Printer Installation

Unpacking Your Card Printer

Your P100i Printer shipsin acardboard carton, protected by styrofoam inserts and a protective
anti-static bag. Keep al packaging material in case you need to move or re-ship the printer.

1.

Before opening and unpacking the printer, inspect the carton to ensure that no damage
occurred during shipment.

Ensure that you have a clean and nearly dust free environment for proper operation and
storage of the printer.

Unlatch and remove the handle, open the carton, and remove the box containing the
printer accessories from the shipping carton.

Remove the styrofoam packing material from the top of the printer.

. Lift the printer out of the carton by holding it on both sides of the bottom and lifting the

printer gently from the carton.
Make sure the following accessories are included with your P100i  Printer:

» Software CD-ROM

*  Quick Start Guide

e Cleaning Kit

o 1 set of Power Cords
* Power Transformer

» USB Printer Cable

If any items are missing, please contact your dealer. To reorder, please refer to Appendix D of
this manual.

980590-001 Rev. A
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Printer Installation
Installing the P100i Printer

Installing the P100i Printer

Caution « Do not power the printer with USB attached to your computer until the driver
has been installed or until prompted by the driver.

Caution « Limit electrical power supplied to the P100i Printer to 24 VDC. Limit excess
current draw to 16 amps or less, using an associated circuit breaker or other such
device. Never operate the printer in a location where operator, computer, or printer can

A get wet. Personal injury could result. The printer must be connected to an earthed
electrical power supply and properly protected against electrical surges and grounding
faults. The power supply pack can only be replaced by the same product from the
manufacturer.

1. Placethe printer in alocation that allows easy accessto al sides. The printer should never
be operated while resting on its side or upside down

2. Remove theyellow CAUTION label from the back of the printer.

=
\;"E‘

\ﬁ |
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Installing the P100i Printer

Printer Installation

3. Ensurethat the printer’s power switch isin the OFF (O) position.

4. Insert the power supply plug into the power socket, attach the power cord (120VAC or

-

-

i

O

230VAC) to the power supply, then plug the power cord in to agrounded el ectrical socket

of the proper voltage and type.

115 VAC
A

230 VAC

by

/

If damaged, the power cable must be replaced by an exact equivalent. The socket
should always be easily accessible to power off the printer.

i Caution « Intermittent or unpredictable operation may occur from unsecured connectors.

980590-001 Rev. A
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Printer Installation

Installing the P100i Printer

5. If your printer has only the USB interface, attach the included USB cable to your

computer and the printer.
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Printer Installation
Installing the P100i Printer

6. If your printer has the optional Ethernet interface (as well asthe USB interface), connect
either the USB cable to printer and computer or the Ethernet cable to the printer and the

Ethernet network.

Ethernet
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USB

Important « Do not connect both the USB and the Ethernet interfaces at the same time!

980590-001 Rev. A
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Printer Installation
Installing the Printer Driver

Installing the Printer Driver

14

Important « Do not power the printer with USB attached to your computer at thistime. The
driver will prompt you when it istime to plug in and power up your printer.

To install the P100i Printer on Windows 2000, Windows XP, Windows Server 2003, or
Windows Vista operating systems, insert the User Documentation and Drivers CD, included
with your printer, into your computer; and the InstallWizard will walk you through the
required installation steps.

The Install Wizard will:
» Automatically install the User Interface when the driver CD isinserted.

» Start theinstallation process when the Install Printer Driver menu item is selected from
the Main Menu.

* Allow youtoinstall Ethernet drivers, if you plan on networking your card printer.
» Check to see which operating system you are using.

» Detect previous versions of the driver and clean up any unnecessary Windows registry
entries. You must select “Remove” from the install options to remove any previous
driver versions.

e |nstall the new driver files.

* Reboot your computer.

If your User Documentation and Drivers CD does not load automatically:
1. Click on Start, then click on Run.
2. Typed:\index.htm, where d: is your CD drive letter.

3. Click OK.

P100i User’s Manual 980590-001 Rev. A



Printer Installation
Installing the Printer Driver

Print Driver Installation

Install the P100i Printer driver as follows:

1. Insert the P100i User Documentation and Drivers CD into the CD drive of the host
computer. The Select L anguage window will open.

"l\\\‘lllll\\VM
Firiar  Please Select Language
_—
il NN
—

=3

2. From the Select Language window, choose the appropriate language for your system. The
Main Menu will open in the selected language (English shown here, others comparable).

Value Line
P100:
Printer Driver Documentation ~ Support
View README >> View CD README >> Register Your Product **
>> PN >>Warranty * Media List *
Install Printer Driver >> Ethernet FAQ >> P100i
>>P100i
User's Manual *
>> |nstall Adobe Acrobat >> P100i
>> Install ZebraNet Utilities >> Web Site **

* Requires Acrobat
** Requires active internet connection

3. Intheleft column, select Install Printer Driver >> P100i.

980590-001 Rev. A P100i User’'s Manual 15
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Printer Installation
Installing the Printer Driver

4. The InstallShield Wizard will launch, and a progress window will be displayed.

Card Printer Solutions
8 Card Frinter Drivers

InstaliShiald Wizard

@ Zebia P10 Card ik Sehup s prepssing e ol ik
Wizard, whach vel guick

" [ T ] = ™
Izt < Back Frith ] e

5. Once the Install Shield Wizard has been installed, the Welcome to | nstallShield Wizard
window will open. Click the Next button.

Zubra P100; Card Printer 1.00.01

6. Onthe Select Featureswindow, you have the option to install USB printer drivers or
ethernet (internal) printer drivers.

P100i User’'s Manual 980590-001 Rev. A



Printer Installation
Installing the Printer Driver

The next two sections detail USB Driver Installation and Ethernet Driver Installation
respectively.
USB Driver Installation

1. Select USB, and click the Next button.

2. Observe the License Agreement window. If you agree to the License Agreement, click
the Yes button.

[Premyre—m

[END USER LICCRSE AGRECHENT FOR ZEBAA TECHROLOGIES SOFTWARL ARD/OR
[FAMWARE - IMPORTANT. READ CAREFULLY. Ho e b conshully inad o urderslond
e right cli T ekw: ' Licerae

980590-001 Rev. A P100i User’'s Manual

17



18

Printer Installation
Installing the Printer Driver

4. Select the appropriate Program Folder, then click the Next button.

fnstall | < Bk L Cancel

6. Read the appropriate information.

7. If you wish, you can open the ReadMe file, which hasinformation about the driver version
you have installed.

P100i User’'s Manual 980590-001 Rev. A



Printer Installation
Installing the Printer Driver

8. Driver installation is now complete. Click the Finish button.

Zubra P100i Card Printer 1.00.01

Instaltshiold Wizsed Complote

Inistal L (T ] [

9. After installing the Driver, restart your computer. When you apply power to the printer,
the Windows New Hardware Found wizard will find the printer.

Ethernet Driver Installation

1. Select Ethernet, and click the Next button.

2. Observe the License Agreement window. If you agree to the License Agreement, click
the Yes button.

Licania Ageanact

[END USER LICCRSE AGRECHENT FOR ZEBAA TECHROLOGIES SOFTWARL ARD/OR

[FAMWARE - IMPORTANT. READ CAREFULLY. Ho e b conshully inad o urderslond
icle el o Licers

980590-001 Rev. A P100i User’'s Manual
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Printer Installation
Installing the Printer Driver

3. Most users should select the Complete setup type; then click the Next button.

P100i User’'s Manual 980590-001 Rev. A
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Printer Installation
Installing the Printer Driver

5. Select the appropriate Program Folder, then click the Next button.

Fahra P10 Card Printar 1.00.01

6. The Install Wizard will show the progress of the installation.

i Card Printer 1.00.0%

7. 1f youwish, you can open the ReadMefile, which hasinformation about the driver version
you have installed.

8. Driver installation is now complete. Click the Finish button.

Fahra D100 Card Printar 1.00.01

9. After installing the Driver, restart your computer. When you apply power to the printer,
the Windows New Hardware Found wizard will find the printer.

P100i User’'s Manual 21



Printer Installation
Setting Printer Driver Options

Setting Printer Driver Options

You can change the default settings for the P100i printer driver. Change the options as
follows:

interface. If you are using the Ethernet interface, the screenswill refer to the “ Zebra P100i

= Note » The screen shots shown in this section are for the P100i Printer using the USB
Network Printer.”

1. Select Start > Settings > Printers and Faxes to bring up alisting of connected printers.

2. From the Printers and Faxes list, right click the P100i USB Card Printer; and select
Properties from the pop-up menu. The Printer Properties window will open.

& 7ebra P100i USB Card Printer Properties @E|
Color Management Security Dievice Settings
General Sharing Parts Advanced

e ﬁ Febra P100i USE Card Printes
Location:
LComment:

Model: Zebra F100i USE Card Printer

Features

Colar: Yes Paper available:
Double-sided: Mo 86mrn=E4rnm Card
Staple: Mo

Speed: Unknown

I aximurn resolution: 300 dpi

[F'r_inting Preferences. .. ] ’ Print Test Page

[ oK ][ Cancel ]

3. Onthe General tab, click on the Printing Preferences button to change the card orientation
settings, monochrome conversion settings, various ribbon settings, or to adjust the color
and head settings properties.

22 P100i User’s Manual 980590-001 Rev. A



Printer Installation
Setting Printer Driver Options

4. On the Sharing tab, you can choose to share the printer over the network, and install
additional driversto accommodate different operating systems.

& 7ebra P100i USB Card Printer Properties

Color Management Security Device Settings
General Sharing | Ports Advanced

"._ \ “t'ou can share thiz printer with other ugers on your network. To
Eié ehable sharing for this printer, click Share this printer,

() Share thiz printer

Dirivers

If this printer is shared with users running different versions of
Windows, you may want to install additional drivers, 2o that the
uzers do not have tao find the print driver when they connect to

the zhared printer.
Additional Drivers...

[ 0K H Cancel ]

5. On the Ports tab, you can add, delete, and configure the printer ports, aswell as choose
which port the P100i Printer is assigned.

& 7ebra P100i USB Card Printer Properties

Color Management Security Device Settings

General Sharing | Parts Advanced

5
@ Zebra P100i USE Card Printer

Frint to the following port(z). Documents will print to the first free
checked port.

Fort Description Frinter -~
O com2: Seial Port

O coM2 Serial Port

O com4: Seial Port £
O FILE:  Print ta File R-Quest Flashlet senes

[0 EME... Zetra Ethernet [inte...  Zebra PE40I

Wirtual printer port fo...  Zebra P100i Card Printer
O use... vitual prinker port fo...  Zebra FE30 Digital Phota Pri..

[ Add Part.. ] [ Delete Part ] [ LConfigure Port...

Enable bidirectional support
[ Enable printer pooling

i) ] [ Cancel

980590-001 Rev. A P100i User’s Manual
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Printer Installation
Setting Printer Driver Options

6. On the Color Management tab, you can add, remove, or change printer color profiles.

& 7ebra P100i USB Card Printer Properties

General Sharing Portg Advanced

Calor Management | Security Device Settings

B Thesze settings let you associate color profile(s] with your color
| printer. Calor profiles contral the color on your printer bazed on the
type of media being uzed and the printer configuration.

whindows will automatically select the best color profile fram
the list of azzociated color profiles [Recommendad]

(O Marual

M anuallp zelect the default color profile for all output fram
thiz device from the list of azzociated color profiles

Default color prafile: <Monex

Color Profiles currently associated with this printer:

Lo JI

Cancel ]

7. Use the Security tab to change permissions for the P100i Printer.

& 7ebra P100i USB Card Printer Properties

General Sharing Ports Advanced
Color Management Security Device Settings

Group or uzer names:

IURTOM:

€5 CREATOR OwMER

m Everyone

!ﬂ Power Users (0TWRPTBURTOM \Power Uszers)

[ Add... ] [ Bemove ]
Permizzions for Administrators Allawy Dy
Pririt O
I anage Printers O
Manage Documents O

Special Permissions

For special permissions or for advanced settings,
click Advanced.

Ok H Cancel ]

P100i User’s Manual
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Printer Installation
Setting Printer Driver Options

8. On the Advanced tab, you can choose various printer properties, install different printer

drivers, and change default printer settings.

& Zebra P100i USB Card Printer Properties

Color b anagement Security Device Settings
General Sharing Ports | Advanced

®;

O.Aval\algle from | | | |

Pricrity:

Diiwer: |Zebra P100i USE Card Printer

v| [ Mews Driver... ]

(® Spoal print documents so program finishes printing faster
(O Start printing after last page is spocled
() Start printing immediately

O Print directly ta the printer

[ Hold mismatched documents

Frint zpooled documents first

[ Keep printed documents

Enable advanced printing features

[ Frinting Defaults... H Print Processor... ][ Separator Page. ..

Ok Cancel

& 7ebra P100i USB Card Printer Properties

Colar Management Secuity ‘ Device Settings

gﬁ Zebra P100i Card Printer Device Settings

PLOGIDMC W1.15.10 »

Prin elfFirm

Encoder Settings.
Tools...

Fi'w Download. ..
Device Information. ..
Single Feed. ..

About, ..

General Sharing Ports Advanced

P100i User’s Manual

9. On the Device Settings tab, you can check the Firmware Version installed on the printer.
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Printer Installation
Setting Printer Driver Options

26

10. Under the Device Settings tab, if you select Encoder Settings, a button “ Properties” will
open next to the Encoder Settings. Click that Properties button, and the following screen

will appear.

Encoder settings

Start of data: =

End of data: %

Advahced settings

The "start of data" characters must be
immediately follawed by a one-digit
number reprezenting the track where

data will be written.

Usze the normal Windows default fonts.

Sample
~CORE 1 2222
~12222

<start_of_datas12222¢end_of_data>

HiCo/LoCo Encoder position Encoder type
() High Coercivity () Reversed @ 150415
(O Low Coercivity ® Nomal Q52
(® Mo Change O BAMYA
[ Festore Defaults ] [ Apply ] [ Cancel l [ Help

X]

Typically, the only setting that a User might change is to switch between High Coercivity
and Low Coercivity Magnetic Stripe cards. A User should leave all other settings

unchanged.

11. Oncethe P100i printer driver options are set to your satisfaction, click the OK button to
save your new configuration and close the Properties window.

P100i User’s Manual

980590-001 Rev. A



3

P1001 Printer Setup

Printer Features

The following shows an interior view of your P100i Printer.

Print

Card and
Cleaning
Roller
Storage
Area

Ribbon
Cartridge

Card
Cleaning
Cartridge

Card
Entry / Exit
Slot
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P100i Printer Setup
Loading Ribbon Cartridge

Loading Ribbon Cartridge

The P100i Printer requires approved ribbon cartridges. The Resin Thermal Transfer and Dye
Sublimation ribbons are specificaly designed for your P100i Printer.

» | SeriesPrintersrequire the use of i Seriesribbonsfor full color printing.

» Each ribbon cartridge includes an integrated adhesive cleaning roller assembly that is
used to clean the cards entering the printer. Improper cleaning will reduce printer life
and degrade print quality

»  When theribbon is completely used, change the whole cartridge assembly.

Electrostatic Discharge Caution « DO NOT TOUCH the print head or the electronic
components on the print head. Discharge of electrostatic charge from the human body or other
surfaces can damage the print head or other electronic components

1. Open printer lid by pressing the Cover Release button on the top of your printer.

2. Peel protective wrapper from adhesive cleaning roller by gently pulling on the tape.
Discard the protective wrapper.

~—

[

el 3 L
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P100i Printer Setup
Loading Ribbon Cartridge

3. Insert the ribbon cartridge with the cleaning roller facing down, so the gears on the ends of
the rollersfit into the appropriate slots.
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P100i Printer Setup
Installing the Cleaning Cartridge

Installing the Cleaning Cartridge

The Cleaning Cartridge removes surface dust particles and oil from the card surface, resulting
in better printing.

A new printer will have a Cleaning Cartridge installed, but its Cleaning Roller will have a
protective wrapper that must be removed.

1. Locate the Cleaning Cartridge.
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P100i Printer Setup
Installing the Cleaning Cartridge

3. Gently squeeze the clips and lift the Cleaning Cartridge free of the printer.

4. Liftthelid of the Cleaning Cartridge. A new printer will have a Cleaning Roller with its
protective wrapping. Replace the Cleaning Roller when it is dirty.

New Dirty
Cleaning Cleaning
Roller with Roller, Must
Protective be Replaced
Wrapping

5. Remove the Cleaning Roller from the Cleaning Cartridge. (Discard a dirty Cleaning
Roller, and replace it with anew one.)

6. Remove the protective wrapper from the Cleaning Cartridge.

4-
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P100i Printer Setup
Installing the Cleaning Cartridge

7. Place the Cleaning Roller in the Cartridge, close the lid, and insert it in place so the
latches engage.

8. Close the printer lid, and push down until you hear an audible click

Note « After thelid is closed, the ribbon automatically synchronizes when the printer power
i ison.
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P100i Printer Setup
Inserting Cards

Inserting Cards

Cards areinserted one at atime into the slot on the front of the P100i . The card is printed on
the top surface and gected out through the same slot.

Important » Handle the cards only by the edges.

The following figure shows the encoding orientation for contact smart-cards and cards with a
magnetic stripe.

For magnetic-stripe cards, if printing is desired on the side with the magnetic stripe, the card
would be inserted stripe up, with the stripe toward the right side of the printer as viewed from

the front.

For contactless smart-cards, orientation is not a consideration.
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P100i Printer Setup
Printing a Test Card

Printing a Test Card

With Ribbon Cartridge and Card Cleaning Cartridge loaded, your P100i Printer is ready to
print. To check the operation of the printer, you should print atest card.

1. Place the printer power switch in the OFF (O) position.

2. While holding down the Multi-Function Control Button, place the printer power switchin
the ON ( |) position. The LCD status window will glow blue.

Multi- Power
Function Switch
Control
Button

3. Keep pressing the Multi-Function Control Button until you are prompted to insert a card.

4. Insert acard into the card entry slot. At this point, you can release the Multi-Function
Control Button.

5. A test card will print after afew seconds and then exit the printer.
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P100i Printer Setup
Printing a Test Card

Storing Extra Cards and Cleaning Rollers

The P100i Printer includes a storage area where you can keep up to 100 extra cards (four
groups of 25 cards) and up to three extra Cleaning Rollers.

Important » Handle the cards only by the edges.
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P1001 Printer Operation

Printing

Printing with the P100i Printer requires the Windows Printer Driver, your card design/issuing
software or printer command level programming through the printer interface.

The P100i Printer can be used with any Windows 2000, Windows XP, or Windows Vista
software application program, using the drivers provided on CD with the printer. Refer to
Chapter 2 for instructions on installing the P100i printer driver.
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P100i Printer Operation

Printing

Creating a Sample Card

Before you begin a new printing session, print a sample card to ensure that the cards will be
printed correctly. Follow the steps below to print your first card using the True Colours™
Card Printer Ribbon Cartridge and the Windows printer driver.

Note » To simplify creating a sample card, you can use one of the sample files that were
installed during the driver installation process. These samples (Word files) can be found in
Sart > All Programs > Zebra Card Printers.

1. Go to the Microsoft Word Software.

2. If the P100i Printer was not selected as the default printer, go to File > Select Printer; and
choose Zebra P100i Card Printer from the printer names list. Close the Print dialog box.

3. Goto File > Page Setup.

4. Select the Size tab; and under Paper Size, choose Card. Under orientation, select
Landscape or Portrait.

5. Select the Margins tab; and set the Top, Bottom, Left, and Right margins to O (zero).
6. Press OK to close Page Setup window.
7. The card appears on the window.

8. Design a card with both black and colored text and with colored pictures similar to the
sample card shown below.

B RN
SAMPLE CARD

M. CHRIS JONES
SALES DIRECTOR

e http://www.zebracard.com

_J
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Printing a Sample Card

P100i Printer Operation

Printing

Once you completed creating your sample card, you are ready to print. Ensure your printer has
aTrue Colours™ Card Printer Ribbon Cartridge installed. Refer to Chapter 3 for instructions
on installing the ribbon and loading the cards.

Print your sample card as follows:

980590-001 Rev. A

1. Select File> Print to open the Print dialogue box.

e 2]
tinter
Mame: @ Febra P1000 1USE Card Prinker Properties |
Status: Idle
Type: Zebra P100i IUSE Card Printer
wWhere: LPTL: I Print ko File
Comment:
'age range Copie:
= gl Murnber of copies: m
' Current page € =Selection
" Pages: I Iﬁ Hq I Collate
Erter page numbers andfor page ranges '
separated by commas. For example, 1,3,5-12
rZoom
Prink what: IDucument j Fages per sheet: m
Print: [ pages in range x| | Seale topaper size: [ scaling vl
Optians. .. | Close |

2. Ensure the following settings in the Print dial ogue box:

* Printer Name: Zebra P100i

e PrinttoFile Unchecked

* Page Range: All

*  Number of Copies. 1

« Collate: Unchecked

e Print What?: Document

e Print: All pagesin range
e Pages per sheet: 1 page

» Scaleto paper size: Noscaling

3. Click the OK button.

Card Printer

4. The user will feed in acard and start printing. The data download time will vary
depending on the complexity of the card design and the processing speed of the compuiter.

5. Once the printing is completed, the card is ejected from the printer.

6. Check the card for any discrepancies. If the sample card is correct, your P100i Card
Printer is ready to produce more cards. For print quality issues, refer to Chapter 6.

P100i User’s Manual
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Cleaning

Cleaning the System

Caution ¢ PROTECT YOUR FACTORY WARRANTY!
The recommended maintenance procedures must be performed to maintain your
. factory warranty. Other than the recommended cleaning procedures described in this
é manual, allow only Zebra authorized technicians to service the P100i Printer.

NEVER loosen, tighten, adjust, or bend, etc., a part or cable inside the printer.

NEVER use a high-pressure air compressor to remove patrticles in the printer.

Your P100i Printer includes a simple cleaning system using Pre-Saturated Cleaning Cards
provided. Theregular use of these cardswill clean and maintain important parts of your printer
that cannot be reached: including Printhead, the Transport Rollers, and the Magnetic Encoder
Station (optional feature).

When to Clean

Clean the Printer when:
« Print quality has been degraded.

* The LCD panel displaysthe message CLEAN PRINTER.
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Cleaning

Cleaning the System

How to Clean

1.

10.

L eave power on.

Multi-Function
LCD Panel

Multi-Function
Control Button

Printer Path
Cleaning Card

. Press and hold the Multi-Function Control Button for 5 seconds.

. When the cleaning cycle isinitiated, the LCD message REMOVE RIBBON THEN

CLOSE LID will display.

. If thelid is opened and closed without removing the ribbon, the message REM OVE

RIBBON THEN CLOSE LID will remain.

. After theribbonisremoved and thelid is closed, the messages CHECKING RIBBON and

CLEANING CYCLE will display.

. The message FEED LONG CLEANING CARD IN EXIT will display. When the card

sensor registers the presence of the cleaning card, the rollers should take the card into
the printer.

. The message CLEANING HEAD will display.
. The message CLEANING ROLLERSwill display.

. When the cleaning process is done, the printer will gject the cleaning card. If the card

sensor still senses the cleaning card, the message REMOVE LONG CLEANING CARD
will display.

After the card is removed, the LCD will display READY. You may now reload the ribbon
and continue printing.
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Cleaning
Cleaning the Printhead

Cleaning the Printhead

Use of the cleaning cards will normally do an adequate job of cleaning the printer. However, a
separate Printhead cleaning, using swabs, can remove more stubborn deposits when print
anomalies persist. To avoid deposits, only use foam-tipped swabs.

Caution ¢ Never use a sharp object to scrape deposits from the Printhead. Permanent
damage to the Printhead will result

1. Place the printer power switch in the OFF (O) position.

2. Open printer lid by pressing cover release button, and open cover fully to revea the
Printhead mounted to inside of the cover.

3. Clean the Printhead by moving alcohol-moistened swab tip side-to-side across Printhead
elements. Only use moderate force.

4. Allow two to three minutes for the Printhead to dry before placing the printer power
switch in the ON (| ) position.

5. To reorder swabs, reference the P100i Printer MediaList.
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Troubleshooting

Troubleshooting Procedures

LCD Panel Warnings and Error Messages

980590-001 Rev. A

WARNING MESSAGES (printer will still operate)

Problem / Symptom

Description or Cause

Possible Solution *

CLEAN PRINTER

Printer needs to be cleaned (this
message is displayed after 1000
cards have been printed).

Clean the printer. Refer to
Chapter 5 for details on how to
clean the printer.

CHECKING RIBBON

Printer is detrmining type of

No action required -- status

ribbon installed. message only.
CLEAN MAG HEAD The magnetic encoder head Use the standard cleaning card
needs cleaning. process described in Chapter 5.
INVALID MAGNETIC DATA The magnetic data may be Check data format.
invalid.

REMOVE RIBBON

Displayed during the printer
cleaning process described in
Chapter 5.

Remove the ribbon.

* |f the problem persists, contact Technical Support; see Appendix D.

P100i User’s Manual
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Troubleshooting
Troubleshooting Procedures

ERROR MESSAGES (printer will not operate)

Praoblem / Symptom

Description or Cause

Possible Solution *

CHECK RIBBON

Ribbon may be improperly

Reload ribbon cartridge. Refer

installed. to Chapter 2 for details on
loading aribbon cartridge.
OUT OF RIBBON Ribbon may be entirely used Load anew ribbon cartridge.

Refer to Chapter 2 for detailson
loading aribbon cartridge.

MECHANICAL ERROR

A mechanical error occurred;

Remove jammed card.

e.g., card jam.
COVER OPEN The cover is open. Make sure that the cover is
completely and securely closed.
PARAMETER ERROR A parameter error occurred. Reset the Printer, and try

printing the card again.

COMMAND ERROR

A command error occurred.

Reset the Printer, and try
printing the card again.

CONTACT ERROR A contact error occurred. Reset the Printer, and try
printing the card again.
CONTACTLESS ERROR A contactless error occurred. Reset the Printer, and try

printing the card again.

INVALID CONTACT DATA

The contact dataisinvalid.

Reset the Printer, and try
printing the card again.

INVALID CONTACTLESS DATA

The contactless dataisinvalid.

Reset the Printer, and try
printing the card again.

* |f the problem persists, contact Technical Support; see Appendix D.

P100i User’s Manual
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Troubleshooting
Troubleshooting Procedures

Print Quality Issues

This section will help you resolve print quality problems The print quality is dependent on
several factors. The two most important factors that will increase your print quality are
cleanliness and card stock. To diagnose and fix print quality problems, follow the
troubleshooting procedures below:

Example « Small spots appear on the printed card with a non-printed area or a different color.

Possible Cause:
» Contamination on the card surface.
Solutions:
» Check that cards are stored in a dust free environment.

» Useadifferent supply of cards.

Possible Cause:

» Cleaning roller not installed.

* Dust inside the Printer and/or dirty Cleaning Roller.
Solutions:

» Clean the printer (refer to Chapter 5)

» Check that the protective cover was removed from the ribbon cartridge cleaning roller
(refer to Chapter 3).

* Replace the Cleaning Roller (refer to Chapter 3).
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Troubleshooting
Troubleshooting Procedures

Example ¢ There are non-printing horizontal lines (white) on the card surfaces.

7

é////////////////////////////

7

Possible Cause:
* Ribbon cartridge is not correctly positioned.
Solutions:

» Ensurethat the ribbon is properly rolled onto the ribbon cores of the cartridge and that
there are no wrinkles in the ribbon.

* Replace ribbon cassette.

Possible Cause:
* Printhead isdirty.
Solution:

» Clean the Printhead (refer to Chapter 5).

Possible Cause:
» Printhead elements are damaged (e.g., scratched or burnt).
Solution:

» Cadll Zebra Customer Service for Printhead replacement information.
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Troubleshooting
Troubleshooting Procedures

Example ¢ Printing shows very pale or inconsistent results.

980590-001 Rev. A

Possible Cause:
* Ribbon cartridge have been stored improperly or is damaged.
Solution:

» Change ribbon cartridge and print again.

Possible Cause:
» Cards may not meet specifications.
Solution:

» Useadifferent supply of cards.

Possible Cause:
» Contrast and/or Intensity may be set to values which are too high.
Solution:

» Adjust Contrast and/or Intensity values in software.

Possible Cause:
* Dust or embedded contamination on elements of the Printhead.
Solution:

e Clean the Printhead (refer to Chapter 5).

P100i User’s Manual
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Troubleshooting
Troubleshooting Procedures

Example ¢ Printing shows blurry printed image.

A

Possible Cause:
« Ribbon cartridge may not be correctly positioned.
Solutions:

» Check that the ribbon is properly rolled onto the ribbon cores of the cartridge, with
nowrinkles.

» Replace ribbon cartridge, making sureit locksin place, and print again.

Possible Cause:
» Ribbon may not be synchronized on the correct color panel position.
Solution:

* Openlid, then close lid to synchronize the ribbon.

Possible Cause:
» Cards may not meet specifications.
Solution:

» Useadifferent supply of cards.

Possible Cause:

» Dust or embedded contamination inside the Printer and/or dirty Cleaning Roller.
Solutions:

« Clean the Printhead (refer to Chapter 5).

* Replace the Cleaning Roller (refer to Chapter 3).
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Troubleshooting
Troubleshooting Procedures

Example ¢ No printing on the card.

Possible Cause:
» Ribbon cartridge may not be installed in the printer.
Solution:

» Check for ribbon cartridge in the printer.

Possible Cause:
» Cards may not meet specifications.
Solution:

e Useadifferent supply of cards.

Possible Causes:

» Cable on Printhead may be disconnected.

» Printhead elements may be scratched or burnt.
Solution:

» Call Servicefor Printhead repair or replacement information.

980590-001 Rev. A P100i User’s Manual
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Troubleshooting
Troubleshooting the Ethernet Connection and Adapter

Troubleshooting the Ethernet Connection and Adapter

Ethernet Adapter Status Indicator

A bi-color Status Indicator displays the operational status of the Ethernet Adapter.

| IR A | \ | I W
Ethernet Adapter Status Indicator

The following conditions might occur:

1. During normal operation, the LED is solid for more than 30 seconds. This
indicates all the hardware is functioning properly, and the Ethernet Adapter has detected
the presence of the network. It does not mean the Ethernet Adapter has an IP address or is
attached to a printer queue.

2. If the LED israpidly flashing (9 times/sec), the Ethernet Adapter has not
detected the presence of a network cable. To solve the problem:

» Verify that the network cable is appropriate and has an RJ-45 connector.

* Turn the printer power OFF (O). Remove the network cable from the Ethernet
Adapter. Plug the network cable back in until you hear a positive click. Check the
other end of the cable in the same manner. Turn the printer power on; if the Ethernet
Adapter still does not detect a cable, continue.

» Connect the Ethernet Adapter to a known good network connection. If the Ethernet
Adapter is still unable to detect the network cable, contact Technical Support

Important « Cables with arating higher than CAT-6 have not been tested.
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Troubleshooting
Troubleshooting the Ethernet Connection and Adapter

3. If the LED isslowly flashing (1 time/sec), the Ethernet Adapter istrying to print

ajob. If the job does not print, check the following:

» Verify that the printer has media and ribbon. If the printer is showing any errors, itis
unlikely that the Ethernet Adapter can send data to the printer. The LED continues to
blink until the printer malfunction is resolved or until the printer is turned OFF (O).

» A flashing RED indicates the Power On Self Test (POST) isin progress.

4. If the LED issolid RED for more than 30 seconds, the Ethernet Adapter has failed the

POST. A failed POST can be caused by any of the following:

» The printer attached to the Ethernet Adapter device is malfunctioning. Turn the
printer power off, wait 10 seconds, then turn the printer back ON (| ).

 If the Ethernet Adapter still fails the POST, the Ethernet Adapter has a hardware
problem that can be fixed only by replacing or returning the unit. Contact Technical
Support for repair or replacement information.

5. If the LED is dternately flashing RED and for longer than 2 minutes, the

980590-001 Rev. A

Ethernet Adapter isin firmware-download mode. This meansit is waiting for new
firmware data to be sent before it continues normal functioning. Do the following:

« If the Ethernet Adapter was purposely put into firmware-download mode, finish
the download with the proper update utility.

e Contact the Zebraweb site at http://www.zebracard.com, and click on the Drivers
& Downloads tab.

¢ Contact Technical Support for help recovering this unit.
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Troubleshooting
Troubleshooting the Ethernet Connection and Adapter

Network Status/Activity Indicator

A bi-color Network Status/Activity LED indicates network speed, established link, and
network activity.

io o
\—l_‘ | AN I
\— Network Status / Activity Indicator

1. If the LED is off, no link was established.

2. If the LED is solid , a100Base link is established.
3. If the LED isflashing , a100Base link is established, and network activity has
been detected.

4. If the LED issolid ORANGE, al10Baselink is established.

5. If the LED isflashing ORANGE, a10Base link was established, and network activity has
been detected.

Network activity detected by this LED does not mean the activity is data for the print server.
The activity is all activity on the network seen on the Ethernet Adapter.
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Troubleshooting
Troubleshooting the Ethernet Connection and Adapter

Resetting to Factory Defaults

To reset the Ethernet Adapter configuration parameters to the factory defaults:

1. Pressthe Ethernet Reset Button, and hold it in while turning the printer power ON ( | ).

oo I—'J;"'—I

| I B \ | A W |
Ethernet Reset Button

2. Keep the Panel Button pressed until the Status Indicator light turns

3. Then release the Ethernet Switch.

Printing a Configuration Card

To print a configuration card, press and hold the Ethernet Switch until a card starts to print.

980590-001 Rev. A
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Technical Specifications

Printer Specifications

General

Color Printing

Bar Code

Cards

980590-001 Rev. A

Load-N-Go™ drop-in ribbon cartridge
16-digit LCD display

Driver for Windows 2000, Windows X P, Windows Server 2003, and
Windows Vista

Color dye sublimation or monochrome thermal transfer printing
300 dpi (11.8 dotsyfmm) print resolution

Code 39, Code 128 B & C with & without check digit
2 0of 5& 2 of 5 Interleaved
UPC-A, EAN 8, and EAN 13

PDF-417 2D bar code and other symbologies can be printed via
Windows drivers

Types. PVC, PVC Composite

Card width/length: 1SO CR-80-1SO 7810, 2.12 in (54 mm) x 3.38 in (86 mm)
Magnetic Stripe-1 SO 7811

Smart Card - Contact and Contactless: 30 mil (.76 mm) to 40 mil (1.02 mm)
Card thickness: 10 mil (.254 mm) to 40 mil (1.02 mm) (£10%)
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Technical Specifications
Printer Specifications

Ribbon Cartridges
» Load-N-Go™ ribbon cartridge with integrated card-cleaning roller
» | Seriestechnology featuring contact-chip-based ribbon detection
*  YMCKO: 200 cards/cartridge
*  Monochrome: 1000 cards/cartridge in black or blue; 850 cards/cartridge

inwhite

Interfaces

* USB 1.1 (cable included)

» USB 1.1 and built-in Ethernet (optional)
Dimensions

e Width: 7.9in (201 mm)

» Depth: 12.9in (328 mm)

e Height: 9.25in (235 mm)

*  Weight: 10.0 Ibs (4.5 kg)
Electrical

e 110~ 240 Volts AC, 50 ~ 60 Hz (auto switching)
« 8 MB image memory standard
* FCCClassA, CE, UL, and CUL approved

Environmental
e Operating Temperature: 60°F to 86°F (15°C to 30°C)
»  Operating Humidity: 20% to 65% non-condensing
»  Storage Temperature: 23°F to 158°F (-5°C to 70°C)
*  Storage Humidity: 20% to 70% non-condensing
* Ventilation: Free air

Options
» Magnetic encoder (30 mil cards only), 3 track HiCo/LoCo
»  Ethernet (10/100 MBps); available at time of order only
o P100i Starter Kit (100 - 30 mil PV C cards and one Black ribbon)
» Cleaning Kit (1 cleaning card and 1 cleaning swab)
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Technical Specifications
Card Dimensions

Card Dimensions

ISO standard dimensions for plain card

2.125 +0.002 in
(53.98 + 0.050 mm)

| J

ta——— 3.375+0.010 in ——

Radius (85.72 + 0.25 mm)
0.125in
(3.18 mm)
0.009 ~ 0.034 in

(0.23 ~ 0.84 mm)

ISO standard dimensions for magnetic stripe card

\ 0.218 in (5.54 mm) max

MAGNETIC STRIPE

0~0.115 in (2.92 mm) 0~0.115 in (2.92 mm)
— e
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Technical Specifications
Declarations of Conformity

Declarations of Conformity

EMC Directive EN 55022 (1998) RF Emissions control
89/336/EEC — " o for red
modified by EMC Directive | EN301489-3v14.1 | o Emissonsandimmunity for radio
92/31/EEC and equipment
93/68/EEC i - i
EMC Directive ENS5024 (2001) | [Mmunity to Electro-Magnetic
Disturbances
73/23/EEC modified Low voltage
by 93/68/EEC Directive EN 60950-1 (2001) Product safety
1999/5/CE R&TTE Directive EN300330-2V1.1.1 | Radio Frequency Interferences

For aformal certificate, please contact the Compliance Office at Zebra's Camarillo facility.

C € EUROPE: Norway Only: This product is aso designed for IT power system with phase-to-
phase voltage 230V. Earth grounding is viathe polarized, 3-wire power cord.

FlI: “Laite on liitettéva suojamaadoitus koskettimilla varustettuun pistorasiaan”
SE: “Apparaten skall andutastill jordat uttag”
NO: “Apparatet matilkoples jordet stikkontakt”

FCC Regulations

Model P100i has been tested and found to comply with the limitsfor a Class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in acommercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and operated in accordance with the P100i User’s Manual, may cause harmful
interference to radio communications. Operation of this equipment in aresidential areais
likely to cause harmful interference in which case the user will be required to correct the
interference at his own expense.

Pursuant to Part 15.21 of the FCC Rules, any changes or maodifications to this equipment not
expressly approved by Zebramay cause harmful interference and void the FCC authorization
to operate this equipment.

FCC Radiation Exposure Statement (applicable to 15.247 device only)

This equipment complies with FCC radiation exposure limits set forth for an
uncontrolled environment. This equipment should be installed and operated with
minimum 20 cm between the radiator and your body. This transmitter must not be
collocated or operating in conjunction with any other antenna or transmitter unless
authorized to do so by the FCC.

Industry Canada Notice

This device complies with Industry Canada |CES-003 class A requirements.
Cet équipement est conforme al 'ICES-003 classe A de la Norme Industrielle Canadienne.
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Appendix A

Magnetic Encoder

Introduction

This section contains information on the additional operations of the P100i Printerswith a
Magnetic Encoder.

The magnetic encoder can be set for either high coercivity (HiCo) or low coercivity (LoCo).

This setting can be made via a third-party application software or viathe Printer Driver:
Device Settings > Encoder Settings.
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Magnetic Encoder
Media Loading Orientation

Media Loading Orientation

Caution « ONLY USE cards that comply with ISO 7810 & 7811 standards for magnetic
A stripe cards. The magnetic stripe must be flush to the surface of the card to work properly.
Never use cards which have taped-on magnetic stripes.

When loading cards with magnetic stripes into the card feeder, ensure that the magnetic stripe
is toward the right side when facing the printer and down, as shown below.

S Note « Zebra approved HiCo & LoCo PVC cards are available. (Reference P1oo: printer
& BT

Magnetic Encoder Cleaning

Use the standard cleaning card process as described in Chapter 5. This process cleans the
most important parts of the printer; including the Printhead, Transport Roller, and
Magnetic Encoder.
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Magnetic Encoder
ISO Standard Encoding

ISO Standard Encoding

Track # |Field Separator |Track Density | Valid Characters |# of Characters

Alphanumeric
1 A 210 BPI* ASCII 79t
20~951

Numeric
2 = 75BPI* ASCII a0t
4862

Numeric
3 = 210 BPI* ASCII 10713
48~62

*  Bitsperinch
T Exceptthe“? character

¥ Including Start, Stop, and LRC characters. Note that these three characters are
automatically managed by the magnetic encoder according to the ISO
Standard Norms.

Note * Refer to the Card Printer Programmer’s Manual for complete programming
information.
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Appendix B

Smart Card Encoder

Introduction

This section contains information on the additional operations of a P100i Printer equipped
with optional contact and/or contactless smart card encoders.

Smart cards can have a built-in microprocessor and/or memory.

Contact smart card encoders physically make electrical connection via a contact pad on the
card. Contactless smart card encoders utilize a short-range radio signal.

Use of either type of smart card encoder is entirely under control of the third-party application
program -- no operator action is required.

Media Loading Orientation

Contact Smart Cards

Orient the cards with the gold-plated Smart Card contacts at the top surface of the card and
nearer the card entry slot, as shown below.

Smart _ —~ —
Card N
Contacts \
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Smart Card Encoder
Printing on Smart Cards

Contactless Smart cards

For contactless smart-cards, orientation is not a consideration (unless the card will be printed
on; see below).

Printing on Smart Cards

Contact Smart Cards

When designing material to be printed on Contact Smart Cards, be sure the printing will not be
on the contact area.

Contactless Smart Cards

When designing material to be printed on Contactless Smart Cards, be sure the printing will
not be on the smart chip area(i.e., the printing on either side of the card must not be on top of
or underneath the smart chip area).

By looking at an unprinted card very carefully, it is possible to see the chip location (asin the
figure onthe left below). If you print in that area, resultswill be unsatisfactory (inthe figure on
the right, the “ star” should have been a single solid color).

X )1 J
\

Smart Chip Location
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Appendix C

Connecting to a Network

Card printers can be connected to an Ethernet network in three ways.

Printer Sharing

In printer sharing, the printer is connected locally to the host computer and configured to be

shared to other client computers. Client computers connect to the printer over the network
through the host computer.

LI 1L
f=
L1
'!
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Connecting to a Network
External Print Server

External Print Server

A stand aone device that acts as a server on the network specifically for receiving print jobs
and passing them to the printer. Client computers connect to the print server over a network.

Internal Print Server

Similar to an external print server, except the print server isintegrated into the printer. This
removes the need for a separate power supply and separate device drivers. Thisisthe simplest
way to network a printer.
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Appendix D

Worldwide Support

For Technical Support or Repair Services, contact the appropriate facility listed below.

North America - Technical Support

Zebra Technologies

Card Printer Solutions

1001 Flynn Road

Camarillo, CA 93012-8706 USA
Phone: 1-800-511-9909

email: techsupport@zebra.com

North America - Repair Services

Before returning any eguipment to Zebra Technol ogies Corporation for in-warranty or out-of-
warranty repair, contact Repair Services for a Return Materials Authorization (RMA) number.
Repack the equipment in the original packing material, and mark the RMA number clearly on
the outside. Ship the equipment, freight prepaid, to the address listed below:

Zebra Technologies
Card Printer Solutions
1001 Flynn Road
Camarillo, CA 93012-8706 USA
Phone: 800-452-4034 or 1-805-578-1201

email: repair-ca@zebra.com
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Worldwide Support

Europe, Middle East, and Africa - Technical Support

Zebra Technologies Card Printer Solutions
The Valley Centre, Gordon Road
High Wycombe
Buckinghamshire HP13 6EQ
United Kingdom
Phone: + 44 (0) 870 241 1527

e-mail: cardts@zebra.com

Europe, Middle East, and Africa - Repair Services

Before returning any eguipment to Zebra Technol ogies Corporation for in-warranty or out-of-
warranty repair, contact Repair Services for a Return Materials Authorization (RMA) number.
Repack the equipment in the original packing material, and mark the RMA number clearly on
the outside. Ship the equipment, freight prepaid, to the address listed below:

Zebra Technologies Corporation
Zebra Card Printer Solutions
Pittman Way, Fulwood
Preston, PR2 92D
Lancashire, U. K.
Phone: 44 (0) 1772-693-069
FAX: 44 (0) 1772-693-046

email: repairupdate@zebra.com

Latin America - Technical Support

Zebra Technologies
Card Printer Solutions, Latin America
9800 NW 41st Street, Suite 220
Doral, FL 33178 USA
Phone: + 1 (305) 558 3100, extension 2821

e-mail: techsupport@zebra.com
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Worldwide Support

Latin America - Repair Services

(Please contact North America Repair Services.)

Asia Pacific - Technical Support and Repair Services

Before returning any eguipment to Zebra Technol ogies Corporation for in-warranty or out-of-
warranty repair, contact Repair Services for a Return Materials Authorization (RMA) number.
Repack the equipment in the original packing material, and mark the RMA number clearly on
the outside. Ship the equipment, freight prepaid, to the address listed below:

Zebra Technologies Asia Pacific, LLC
16 New Industrial Road
#05-03 Hudson TechnoCentre
Singapore 536204

Phone; + 65 6885 0833

e-mail: esoh@zebra.com

Website

www.zebracard.com
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